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Using o2c 
 

What is o2c? 
o2c displays three-dimensional, freely movable objects. Developed by mb Software, o2c depicts 3D objects as 
photo-realistic and fully interactive entities for use on the Internet, and in standard Microsoft® Office applications. 
By combining speed, presentation, user interaction, and animation, the o2c player provides an innovative way for 
you to display objects and information. The o2c player virtually lets you hold the 3D object in your hand. 
 
You can use your mouse to rotate the 3D object, giving you significantly more knowledge than you get by merely 
looking at a static image of it. The o2c player also shows how the object moves with flowing, true-to-life motion.   
 
o2c objects let you incorporate eye-catching graphics in your Web pages and Microsoft Office applications. Even 
outside the Internet, the o2c player can help you spruce up objects for a presentation. By integrating 3D objects in 
documents (text, database, spreadsheet, or presentation), the o2c player stimulates your creativity. As an ActiveX® 
control, the o2c player can be universally employed in the Windows® environment. 
 

Installing the o2c Player 
Installing the o2c player is very quick and easy. When you load an o2c Internet page, the o2c player is 
automatically installed. You can use it immediately in corresponding Office applications as an object or a control 
element.  
 
Note: If you send documents that contain o2c images, the recipient must install the o2c player to view your 
documents in full. Just include the installation file O2CSetUp.exe with your document so your recipient will be 
able to view or edit your document. Alternatively, your recipient can download the setup program from 
http://www.o2c.de/englisch/index.html. 
 

Functions of the o2c Player 
When you move the cursor over the display area of the o2c player, the cursor shape changes to a double cross. This 
lets you rotate the object in all directions when you depress the left mouse button. Depressing the left mouse button 
together with the [Ctrl] key will zoom the object. Moving the cursor down will zoom in, moving it up will zoom 
out. Alternatively, you can start to zoom by depressing the right mouse button. To pan the object in all directions, 
depress the left mouse button together with the [Shift] key. The o2c cursor will change its appearance based on 
these three actions. 
 
Normal Viewing Mode Walk Through Viewing Mode 
Rotate: left mouse button Walk: Left mouse button 
Zoom: right mouse button  Zoom: [Ctrl] + right mouse button 
Move: [Shift] + left mouse button Elevator: [Shift] + left mouse button 
Rotate Up: Up arrow Forward: Up arrow 
Rotate Down: Down arrow Backward: Down arrow 
Rotate Left: Left arrow Left: Left arrow 
Rotate Right: Right arrow Right: Right arrow 



The Context Menu of the o2c Player 
Right-click to open the context menu. The activated or visible parts of the menu depend on how you are using the 
o2c player. The menu may be influenced by certain properties of the o2c player that may be set directly in your 
HTML pages. 
 
Show all  Sets the zoom factor to show the whole object. 
 
Load object… Loads a new object. Enter the object’s file name in the dialog box. This may not be available if an 

Internet page owner will not allow you to save the o2c object. 
 
Save image… Save the current view of the o2c object as a bitmap file. The Save bitmap dialog box appears: 
 

 
In the right-hand portion, specify the graphic’s quality. It takes longer to create a medium or 
high quality image. High quality paired with raytracing takes even longer. Width in pixels lets 
you indicate the resolution of the o2c image. The height is calculated to proportionally match the 
sides of the image shown in the o2c player. If you check Raytrace, the image will be saved with 
light/shadow calculations. 

 
Save object… Saves the object shown with the o2c player to the hard disk directly from the application. This is 

especially important for an Internet presentation. If a 3D object is represented in the Internet in 
the o2c format, you can save it to your hard disk and use it in your own applications. If the o2c 
player has loaded an object in the o2c format, you may save it with the .O2C extension and use it 
in DataCAD Plus vis, ArCon – Visual Architecture, or ArCon-compatible applications. If the 
object represented has not been loaded in the o2c format, you will not be able to save it with the 
.O2C extension. 

  

 



If the Save object... menu is unavailable (inactive or gray), the owner of the 3D object is not 
willing to release the object for further use. 
 

Start raytrace Calculates raytracing for the view on your screen. You can also start raytracing by pressing the R 
button in the controlbar or the [R] key on the keyboard when the controlbar is not active. To 
cancel this process, pressing the [Esc] key. 
 
Note: The o2c player can use up to five processors for raytracing if your PC is equipped with the 
corresponding hardware.  

 
Start animation Requires no action on your part to make things come to life. When you animate a product-

specific, true-to-life sequence of motions, o2c shows the object in its three-dimensional form and 
shows how it works. For example, a wardrobe may open its doors, show its constructive elements, 
and display its interior. If the o2c object animation can do several things, the user can start them 
individually from the context menu. 

 
Animation is available for specially modeled objects only. You can use standard programs (such 
as 3D-Studio® by Autodesk®) to construct 3D objects for o2c. To convert to the highly 
compressed o2c format, requires the 3DS import filter, available in a later version of the o2c 
program that will load 3D objects (in 3DS format) into the import tool and save them in o2c 
format to the hard disk. This future import filter will also allow you to structure and optimize the 
3D object. Objects (project data of existing, unanimated objects) that were created directly in the 
o2c format in ArCon online do not contain animations. 

 
Go to preview Shows enough of the 3D object so that it is partially visible. 
 
Change to  
3D view  Toggles on 3D view of the o2c object. 
 
Background... Allows you to select a background color, tile, or image (from a loaded graphics file) from options 

presented in a dialog box: 
 

  
The Select color… button lets you control the background. The Load image… button lets you 
specify a graphics file for the background. If you use a graphics file, you can use the Tiled 
background picture button and select the X and Y offset to repeat the image. 

 
The Background picture button displays one copy of the image you selected behind the o2c 
object.  
 
The Tiled background picture button does not change the size of the loaded image. If necessary, 
the image will be tiled both horizontally and vertically to fill the background completely. You can 
specify an offset, beginning from the upper left corner. For example, you could use the same 
background image as the one on the rest of an HTML page. By entering the relevant X and Y 
values, you could make the seam between the o2c area and the regular Internet page disappear.  



 
In this version of the o2c player, the Transparent button is gray (unavailable). In a future version, 
you will be able to use a transparent background so you could display the 3D object in front of the 
regular background on your Internet page or within your document. For printed documents, it is 
best to choose a white background. 
 

Display mode Lets you select how you want to display objects from a submenu. Your display options are 
wireframe, wireframe with hidden lines removed, flat shaded, flat shaded with texture, and 
shaded with texture. The Filter feature anti-aliases or smoothes object edges.  

 

  
Wireframe Wireframe with hidden lines removed 

  
Flat shaded Shaded with texture 

 
 
No controlbars Hides the o2c player’s scroll bars so that only the object itself appears. You can still move the 

object with the mouse. When you activate this option, your o2c object will look more attractive in 
your document or on you web page. Depending on the background color or image you use, the 
o2c object can blend into or stand out from the remaining document or web page. 

 
Automatic  
rotation Lets the o2c object rotate by itself. With your left mouse button depressed, just place one of the 

hooks of the o2c cursor on the object and give it a nudge in the direction you want it to rotate. 
When you release the left mouse button, the o2c object will continue to rotate. The speed of 
rotation depends on how hard you nudge the object. You can combine automatic rotation with 
animation. Stop the rotation by clicking near the object with the left mouse button. 

 
Walk-through Lets you walk through the interior of an object (e.g., a house), instead of just looking at its 

exterior. This is identical to the walk-through-mode in DataCAD Plus vis.  
 
General settings Displays a dialog box that lets you specify how to save an object on your PC or integrate it into a 

document file to send/transfer to other computers.  
 



 
Info... Displays information about the version of the o2c player you used and provides links to the o2c 

player’s developer and distributor. Check the web page regularly to see if a newer version of the 
o2c player is available. 

  

 

Control Lights in an o2c Object 
Some o2c objects have lights that you can control using the o2c player. There are five light sources that you can 
toggle on or off to illuminate any o2c object. You can use the 0, 1, 2, 3,and 4 keys on your numeric keypad or 
above the letter keys: 
 
0 All lights on (shown below on the left) or all lights off. Press 0 to toggle all lights on or off. 
1 Light is from the front, lower right (shown below on the right) 
2 Light is from the back, upper left 
3 Light is from the top 
4 Light is from the bottom 
 

   



Embed an o2c Object into Other Applications 
The o2c player you installed on your computer lets you embed object into other applications. After you have created 
an o2c object from your DataCAD model, you can send it to your client as an e-mail attachment. You can also 
incorporate o2c objects into MS Word® documents and save them as HTML files that you can display on your web 
site. 
 
To embed and o2c object into an MS Word document: 
 
1. Create an o2c object and save it. Alternatively, you can place any available o2c object in a document. 
2. Start Microsoft Word and create a new document. 
3. Select Toolbars from the View pull-down menu. Make sure Control Toolbox is activated. 
4. Put your cursor where you want the o2c object to be displayed in your document. 
5. Select Object... from the Insert pull-down menu. The Object dialog box appears with the Create New tab 

on top. 

 
6. Scroll down the list, highlight o2c-Player (mb Software AG), and click OK. An o2c client area appears 

within your document. 

7. Right-click inside the client area to activate the context-sensitive menu. 
8. Highlight o2c-Player (mb Software AG) Object and select Load object... from the submenu. The Load 

object dialog box appears. 



9. Choose an o2c file from the list and click on Open. The o2c object is placed in the client area in your MS 
Word document. At this point, MS Word is in Design Mode. 

10. Select the client area and use the handles to size it to the desired proportions. Or double-click on the 
object to reveal the o2c cursor, right-click for the context-sensitive menu, and make changes to it. 

 
If you are using MS Word 2000, you can change some of the properties of the object; however, in earlier 
versions of MS Word (such as MS Word 97), the Properties option is unavailable. You can make changes 
to many of the properties that offer options from a submenu. For example, the BackColor submenu allows 
you to change the background color of the o2c object. 
 

 
 
When you are finished changing the properties to meet your needs, click on the Exit Design Mode icon 
(shown below) in your MS Word 2000 document. The changes you made are implemented in your o2c 
object within the MS Word 2000 document. 

 
 
11. Select the Exit Design Mode icon (shown above) from the Control Toolbox toolbar when you are finished 

editing the client area and object properties.  
12. Double-click on the object to display the special cursor that allows you to manipulate the object using the 

o2c player controls. 
 



To save the MS Word document as a web page:  
 
1. Select Save As... from the File pull-down menu. The Save as dialog box appears. 

 
 
2. Scroll down to HTML document (*.htm; *.html; *.htx) in the Save as type field.   
3. Enter a name for the document in the File name field. 
4. Select Save. 
 

Where to Find o2c Objects on the Web 
If you want to find more o2c objects, just log onto the Internet and begin your search on the web. Two places to try: 
 
1. Use the BINGOOO browser. You can download this browser for free. Although the initial BINGOOO 

screen appears in German, you can click on the English icon for a translation. 
2. Go to http://www.o2cworld.com and enter a keyword (for example, Architecture) in the “Search for” field.  

Among the many objects available is a model of the Chrysler building (just 92 kb!). 
 


